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Microsoft Office
Word-2003

Creating New Document

Microsoft Word is a powerful and spontaneous word processor. Word allows creating and saving new
document.

To create a new Microsoft Word 2003 document:
Click Start button to display Start menu.

Select Programs — Microsoft Office — Microsoft Office Word 2003 to open Microsoft Word window.
Select File — New or press ctrl + N to open a new document.

7
0’0

7
0’0

X3

S

X3

S

Place the insertion point at the location where you want to type the text.
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Enter the appropriate text.
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Press the Enter key to end a short line or a paragraph and to create a blank line.
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Press the Tab key to move the insertion point "1/2" to right.
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Press the Delete key to remove the character or space immediately to the right of the insertion point.
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Press the Backspace key to delete the character or space immediately to the left of the insertion point.

Saving a Document

Word enables the Save or Save As commands that allow saving a document. You can save your document
permanently on any location of hard disk. The Save As command can be used in three cases, these are: To
save a document for the first time, to save a document with a new/another name and to save a document in
a different location. The Save command allows you to save a document with its current name in its current
location. The Save commands updates a saved document.

The following are the steps to use the Save command:
% Click File — Save
Or
% Click Save on the Standard toolbar.
Or
“* Press the Ctrl + S shortcut key.

To save a new document you need to apply the following steps:
%+ Click File — Save As to display the Save As dialog box.

%+ Select the appropriate location where the document needs to be saved by selecting a folder from the
Save In drop-down list.

J

“* In the File name text box, type the name of the file and click Save.

Opening a Document

MS Word enables to open saved document easily. When you open a file, Microsoft Word places a copy of
the file in an active document window.

To open a document:

“» Select File — Open or Press Ctrl + 0 key or click Open to display the Open dialog box.
“» Select the appropriate location where you want to save a file in the Look in drop-down list.
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“+ Select the document that is to be opened and click Open.

Making Toolbars visible or Invisible
MS Word allows you to make the toolbars visible or invisible according to your requirements.

<& To make the toolbars visible: - Dolwig
%+ Right click menu bar; a popup menu will open, as shown in the following figure. D(,L.,L:'m
“» This popup menu contains a large list of tools bar, such as Standard, Formatting, ‘r::"’
Auto Text, Drawing, Forms, Frame and Tables and Borders. Select the Forms
appropriate tools bar by clicking on popup menu. When you select a Toolbar it ;:;9,
will become visible immediately. ‘ h’::“‘
% If you want to make a visible toolbar invisible, you just need to right click menu | ——

Tables and Borders

bar and click selected tools bar. The selected tool bar is unchecked from list and [Z] Toskpane

toolbar will be invisible on the screen immediately. WS
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Which of the following statements are true?

Statement A: While pressing Ctrl + N short cut key it opens new document.

Statement B: While pressing Ctrl + P short cut key it generates hardcopy of your document.
(A) Statement A is correct

(B) Statement B is correct

(C) Statement A and B are correct

(D) Neither statement A nor statement B is correct

Answer: (c)

Explanation

Correct Option:

(C) Both statements are true.
Incorrect Option:

Rests of the options are invalid.

E] MS Word enables variety of toolbars that allows you to perform various functions in a document. Which
of the following tool bars exist in Word 2003?
(A) Forms (B) Frames
(C) Outlining (D) All of these
(E) None of these

Answer: (d)

Explanation

Correct Option:

(D) Forms, Frames and Outlining toolbars exist in Word 2003.



Incorrect Option:
Rests of the options are invalid.

C]

Jack wants to make Task Pane visible. Which one of the following steps Jack should perform to found
desire output?
(A) Right click menu bar to open the popup menu and click Task Pane.

(B) Click Insert Task Pane (C) Click View — Task Pane
(D) All of these (E) None of these
Answer: (a)

Explanation

Correct Option:

(D) To make the toolbars visible:
Right click menu bar to open the popup menu. This popup menu contains a large list of tools bar. Select the
appropriate tools bar by clicking popup menu, such as Task Pane.
Incorrect Option:

Rests of the options are invalid.
Changing Page Setup i
Word 2003 allows setting page setup according to your requirement. Page s i
Setup includes .page margins and page setting. The blank spaces around the i
edges of the page are called page margins. You can set your page margins s e
according to inserted text and graphics. You can also set some items in the Tapaiid
margins, such as page number, header and footer. ) (s
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To set the page margins:

Select File — Page Setup to open Page Setup dialog box, as shown in the following figure.

Click Margins tab.

Set the margins and orientation.

Click OK.

Word 2003 automatically inserts section breaks (section break: A mark you insert to show the end of a
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section. A section break stores the section formatting elements, such as the margins, page orientation,
headers and footers, and sequence of page numbers.) Before and after the pages with the new paper size.
You can also set paper size according to your requirements.

To change the paper size:

% Select File — Page Setup to open Page Setup dialog box.
%+ Click the Paper tab, as shown in the following figure:
¢+ Click a paper size.

How to view Help

Word 2003 enables Microsoft Office Word Help that gives the answer of your related queries. You can take
advantage of help when you feel typical to do any steps. Word Help enables step by step description of
every word techniques and methods. To open Word Help:



“» Select Help — Microsoft Office Word Help to open the Word Help dialog box, as shown in the following
figure:
Or

“* Press Fl key.

Type the search item in Search for text box and click arrow. Help displays all related information on your

screen. m . X
Spell and Grammar Check R

Microsoft Word enables spelling and grammar checker that provides the facility to check  £3oMesonine
the spelling and grammar in the document. The spelling and grammar checker can be &= """

Gt the latesk oees aboct uang
Woed

executed :0 check the spellings and grammar in the whole document. By default. Word R
checks spelling and grammar as the text is being typed in the document. Wavy red L
underlines indicate possible spelling errors. Wavy green underlines indicate every possible  Hai
grammatical issue. P e—
i i

To start the spelling and grammar checker:

% Select Tools —> Spelling and Grammar to display the Spelling 'mh?w PR

Spelting and Grammar: English (U.S.)

and Grammar dialog box, as shown in the following figure.
“* Click Ignore Once to ignore the spelling mistake or Change to 2
change the word with the suggested spelling.
w  After completing the spelling and grammar checking in the
whole document, a message box appears

% Spelling and grammar check is complete". Elopiwmes T} .
Click OK.
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Changing Appearance of Text

Word enables to change text according to your requirements. You can

Fook Chagacter Spacing  Text Effacts

set appearance of your document text by applying font, font size, bold | &= Fort st P
[rimes tew Romany Reguiar 12
and underline. e — s 3
:mns :::'* :e
Tungs v 12 4
To apply font and font size: i—T | M
% Select the text in the document and click Format -> Font to open the j}w Dows  Ganden
Font dialog box, as shown in the following figure. l:s-q-w’l : 8?:; Do
| Suscrict Engrave
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To set the font, select the required font from the Font list.
“» To set the font style, select the required font style from the Font

0

Times New Roman

style list. T R T T T T T

To set the font size, select the required font size from the Size list. LB, S
To set the font colour, select the required font colour from the Font colour dropdown list.
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The preview of the text can be seen in the Preview section.
Click OK to close the Font dialog box and apply the selected formatting to the selected text.
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MS Word also enables the/allowing alternative methods that you can used to apply
font and font size:



Click Font list on the formatting toolbar to select the font, such as Times New Roman.

¢+ Click Font Size list on the formatting toolbar to select the size of the font, such as 11.
¢ Click Font Colour list to define the colour of the selected text

To bold a particular text:

«» Select text in the document

R/

“+ Click Bold or press ctrl + b key.

To underline a particular text:

R/

+» Select text in the document

0,

+» Click Underline button or press ctrl + u key.

To apply the Italic on a particular text:

/

“» Select text in the document

/

«» Click Italic or press ctrl + i key.

To apply a particular effect on the text:

*» Select the check box for the particular effect such as shadow from the Effects section.

Paragraph Level Formatting

MS Word enables paragraph formatting that includes text alignment, setting margins and line spacing. While

applying formatting it affects the entire paragraph even if a single word is selected or the insertion point is

placed in the paragraph.

To format a paragraph:
Select the paragraph/paragraphs to which the formatting has to be applied.
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list.

MS Word also enables the following alternative methods
to align the paragraph:

L)

» Click Align Left in the formatting toolbar for left aligning the text.
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Click Center in the formatting toolbar for center aligning the text.

L)

“+ Click Align Right in the formatting toolbar for right aligning the text.
“» Click Justify in the formatting toolbar for justifying alignment of the e
Alegr: opt
text.

“ Set the spacing before and after the paragraph from the before and | ..

Select Format — Paragraph to display the Paragraph dialog box, as shown in the following figure:
In the General section, set the alignment of the paragraph from the Alignment drop-down list.
In the Indentation section, set the left, right and special indents from Left, Right and Special drop-down

after drop-don list. The spacing between each line can be set by

selecting a value from the Line spacing drop-down list.

+“» Click OK to apply the formatting. (1]
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Word 2003 allows setting page setup according to your need. To change the page setup you need to open
the Page setup dialog box. Which one of the following is the correct step to open page Setup dialog box?
(A) Select File — Page Setup (B) Select Format — Page Setup

(C) Select Insert — Page Setup (D) Select File Print —> Page Setup

(E) None of these

Answer: (a)

Explanation

Correct Option:

(A) Select File — Page Setup to open page setup dialog box.
Incorrect Option:

Rests of the options are invalid.

Steve's teacher asks him to open Word help and search any query. But his mouse is not working properly.
He wants to open Word help using keyboard. Which one of the following short cut keys he should use to
open Word Help?

(A) F1 (B) F2

(C) Ctrl +S (D) F3

(E) None of these

Answer: (A)

Explanation

Correct Option:

(A) While pressing Fl key it opens word help.
Incorrect Option:

Rests of the options are invalid.

Which of the following steps are true about spell and grammar checker?

(A) The spelling and grammar checker can be executed to check the spelling and grammar in the whole
document.

(B) By default Word checks spelling and grammar as the text is being typed in the document.

(C) Wavy green underlines indicate possible spelling errors.

(D) All of these (E) Both Aand B

Answer: (e)

Explanation

Correct Option:

(E) Statements a and b are correct.

Incorrect Option:

(C) Wavy red underlines indicate possible spelling errors.



Printing Document:

To print document you need to perform the

following steps: R .
. X . i . . Type: HP LaserJat 4200 PCL 6 D;—':'——*
“* Click File menu and select print option to open Print vhrs D
dialog box, as shown in the following figure.
a Nuber of Gooees
or - oS oo
%+ Click the Printer icon on the Standard toolbar. Enter page mbers andor page anges L L

separated by commas. For examgie, 1,3,5-12
In the Copies option, type the number of copies that is | e oocmen v
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. Priek: ‘- R . Poges per sheet -0
to be printed. ; ook AChod Rt S Vo taoe e Sk
List of markup
J H S
% Click OK. Rkt rties . e
(oo leyomgmens | (oo il _sacy |

NOTE: Ctrl + P can be used to print the entire file.

Words Counting
MS Word allows you to count number of pages, words, character (no

space), character (space), paragraph and lines in a document.

Pages
Words

Characters (no spaces)

To apply word count: Chavactars (with spaces)

% Select Tools — Word Count to display the Word Count dialog box, as f::f”hs

OO0 00O -

shown in the following figure. The Word Count Dialog box displays all

information including number of page, words, character (no space), | incude footnotes and endriotes
show Toobar _ |

character (space), paragraph and lines in a document. '

Search and Replace Text ISR B RN |
MS Word provides the facility to search or Fid | Reglace | GoTo
match specific text in the document. You can Find what: | v

also replace the searched text with other text.

This facility is very useful because it minimizes
(7] vighlight l items found in:

the time and effort required for searching the

text in the document.

To open the Find & Replace dialog box:

%+ Select the Edit — Find or Replace menu option or press Ctrl + F short cut key, as shown in the following
figure.
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Enter the word or text, which you want to search for in the Find what list box and click the Replace tab.
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Enter the word that you want to replace in Replace with list box.

*

/
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Click Find Next for finding specified word. This will highlight the word in the whole document.
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*

Click Replace All for replacement of word in the whole document or click Replace to replace the current
highlighted word.

R/
*



Inserting an Image using Clipart
MS Word enables you to insert image or shape in a document. ;’*“;”' “""""”'“"”"”"’

Clipart is a library that provides number of picture. You can [ el [ 8 ooy

) oy st

directly insert those images in your document. To insert an image:

“* Locate the cursor where you want to insert an image.

‘0

% Go to the menu bar and select Insert — Picture — Clipart, as
shown in the following figure.

+» Select the appropriate picture and right-click to open pop
menu | -

“ Click Insert. -

Kerning

Word 2003 enables to adjust kerning in your document. Basically it a process of moving letters closer
together, in an effort to overcome the illusion too much space between letters. It makes the text more
appealing and readable. In Word, kerning can be adjusted either automatically or manually.

To change kerning automatically:

Select the text and right click to open the popup menu.
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Click Font to open the Font dialog box, as shown in the following figure:

Click the Character Spacing tab and adjust the character spading and positions.
Select the Kerning for fonts check box, as shown in the following figure:

Click OK.

5

%

\/
0’0

5

%

Working-with WordArt
Word Art is the excellent feature of Word 2003. Basically it is an auto shape toolbar in Microsoft Word 2003

that allows creating a variety of three-dimensional word shapes in the document. You can change the text,
determine text wrapping points and even modify the orientation of the text.

To insert the word art:

Select the area of the document where you want to place the word art.
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Click anywhere inside the document to select a location for the placement of the word art.
Click Insert WordArt to open the WordArt gallery.

Select the desired word art design.

Click Ok to open the Edit WordArt Text dialog box.

Type the text and set the font and size.
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Click OK to apply all effects

Creating Tables

Some time you need to represent information in tabular forms. Word 2003 enables the facility to insert a
table in word document easily. You can apply various functions, such as insert and delete data. You can also
increase or decrease number of columns and rows according to your requirements.



To insert a table in word document:

Place the cursor where you want to place the table.

Select Table — Insert — Table to display the Insert Table dialog box.
Set the number of columns in the Number of columns text box.
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Set the number of rows in the Number of rows text box.
To close the Insert Table dialog box Click OK.
A table with the defined number of rows and columns will get inserted in the document.
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You can move the cursor in table by tab key or arrow key or click in the appropriate cell. After inserting table
in a document, it can be modified as require. The columns and rows can be added to the table or deleted
from the table.

To add a row:

“* Where the row is to be added above or below in the cell place the insertion point there itself.
*» Select Table — Insert — Rows Below or Rows Above.

To add column:
“* Where a new column is to be added place the insertion point in the column beside that place.
%+ Select Table — Insert — Columns to the Right or Columns to the Left.

To delete rows:

“* The row to be deleted place the insertion point there.
% Select Table — Delete — Rows.

To delete columns:

“* The column to be deleted place the insertion point there.

“» Select Table — Delete — Columns.

Thesaurus

Thesaurus allows looking word in another language. If your document is written in French and you want to
see the synonyms of that word use thesaurus.

A Documentd - Microsoft Office Word 2003 Beta

To use thesaurus:

%+ Click Research on the Tools menu to open the
research dialog box, as shown in the following figure:

*

“* In the Search for list, select Thesaurus.

*,
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Press ALT and click the word you want to look up.

*

“» Results will appear in the Research task pane.

*,
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Jack creates a document. The text of document contains big gap between two letters. Which one of the
following processes Jack will use to move letter closer together?

(A) Kerning (B) Thesaurus

(C) WordArt (D) All of these

(E) Both Aand B

Answer: (a)

Explanation

Correct Option:

(A) Basically kerning is a process of moving letters closer together, in an effort to overcome the illusion of
too much space between letters. Incorrect Option:

(B) Thesaurus allows looking word in another language.

(C) WordArt is an auto shape toolbar in Microsoft Word 2003 that allows creating a variety of three-
dimensional word shapes in document.

Steve writes a document in English language. He wants to check few words in French language. Which one
of the following helps in finding words in another language?

(A) Kerning (B) Thesaurus

(C) WordArt (D) All of these

(E) Both Aand B

Answer: (b)

Explanation

Correct Option:

(B) Thesaurus allows finding words in another language.

Incorrect Option:

(A) Basically kerning is a process of moving letters closer together, in an effort to overcome the illusion of
too much space between letters.

(C) WordArt is an auto shape toolbar in Microsoft Word 2003 that allows creating a variety of three-
dimensional word shapes.

Which one of the following statements is true?

Statement A: The Save As command can be used in three cases.
Statement B: Page Setup includes only page margins.

(A) Statement A is correct

(B) Statement B is correct

(C) Both Statement A and B are correct

(D) Neither statement A nor statement B is correct

Answer: (a)



Explanation

Correct Option:

(A) The Save As command can be used in three cases. Incorrect Option:

(B) Statement B is wrong because page setup includes page margins and page setting.

You Must

KINOW

/

+» Office Assistant provides link to open Word Help

IMPORTANT

TERINS

Kerning: Is a process of moving letters closer together, in an effort to overcome the illusion of too much

space between letters
Word Art: Is an auto shape toolbar in Microsoft Word 2003.
Thesaurus: Allows finding word in another language.

SUMMARY 0)

MS Word enables to open saved document easily.

5

%

5

%

5

%

\/
’0

MS Word enables to make toolbars visible or invisible according to your requirements.

Page Setup includes page margins and page setting.

Word 2003 enables Microsoft Office Word Help that gives the answer of your related queries.

Microsoft Word enables spelling and grammar checker that provides the facility to check the spelling
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and grammar in the document.
MS Word provides the facility to search or match specific text in the document.
The Save As command can be used in the three cases, these are: To save a document for the first time,
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to save a document with a new/another name and to save a document in a different location.
Page Setup includes page margins and page setting.
While applying formatting it affects the entire paragraph even if a single word is selected or the insertion
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point is placed in the paragraph.
“* MS Word provides you to count number of pages, words, character (no space), character (space),
paragraph and lines in a document.

®»  Abbreviations

Additional Tips for Parents
Help the children to draw a table which has 6 rows and 5 columns.



Self Evaluation @ Duration

TEST 15 Minutes

Steve writes a five page documents. He wants to change the font size in all documents. But he is unable to
find font list. Font list is available on the ............cccccc....

(A) Toolbar (B) Formatting toolbar

(C) Menu bar (D) All of these

(E) None of these

C]

Jack has fifty page documents. He wants to count all word. What should he do?
(A) Click Tools — Word Count

(B) Click View — Word Count

(C) Click Tools — Options — Word Count

(D) Click Insert — Word Count

(E) None of these

C]

ClipArt is a library that provides number of picture. Which one of the following is the correct step to open
clipart?

(A) Insert — Clip Art

(B) Insert — Picture — Clip Art

(C) Tools — Picture — Clip Art

(D) Tools — Clip Art

(E) None of these

C]

Which one of the following is the correct step to open Find and Replace dialog box?
(A) Edit — Find (B) Edit — Replace

(C) File > Find (D) Both (A) and (B)

(E) None of these

C]

John wants to use WordArt in his document. But he is not able to search Insert WordArt button. In which
of the following locations insert WordArt button exists.

(A) Drawing toolbar (B) AutoText toolbar

(C) Formatting toolbar (D) Standard toolbar

(E) None of these




Which of the following statements are true about kerning? (A) Kerning can be adjusted either
automatically or manually

(B) It is a process of moving letters closer together

(C) Kerning for fonts check box is available on Font dialog box

(D) All of these

(E) None of these

Which one of the following is the correct step to open Insert Table dialog box?
(A) Select Table — Insert — Table

(B) Select Table — Insert Table

(C) Select Table — Insert — Insert Table

(D) Select Insert — Table

(E) None of these

Which one of the following is the correct step to open change case dialog box?
(A) Select Format — Change Case

(B) Select Format — Paragraph — Change Case

(C) Select Insert — Change Case

(D) Select Edit — Change Case

(E) None of these

C]

Zacob wants to insert an image from clipart. What steps he should perform to open clipart?
(A) Select Insert — Picture -~ ClipArt

(B) Select Insert — ClipArt

(C) Select Insert — From File — ClipArt

(D) Select Insert — Image —> ClipArt

(E) None of these

C]

You can move the cursor in table by.............

(A) Arrow key (B) Tab key

(C) Mouse (D) All of these
(E) None of these




Self Evaluation Test
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Explanation for Selected Questions

1. Correct Option:
(B) Font list is available on the formatting tool bar.
Incorrect Option:
Rests of the options are invalid.

2. Correct Option:
(A) MS Word allows you to count number of pages, words, character (no space), character (space),
paragraph and lines in a document. Click Tools — Word Count to open Word Count dialog box.
Incorrect Option:
Rests of the options are invalid.

3. Correct Option:
(B) Insert — Picture — Clipart allow you to open clipart.
Incorrect Option:
Rests of the options are invalid.

4, Correct Option:
(D) Select Edit — Find or Replace to open Find and Replace dialog box
Incorrect Option:
Rests of the options are invalid.

5. Correct Option:
(A) Insert Word Art button exists on drawing tool bar.
Incorrect Option:
Rests of the options are invalid.

6. Correct Option:

(D) All statements are correct.



Incorrect Option:
Rests of the options are invalid.

7. Correct Option:
(C) Tools menu contains the Spelling and Grammar check option.
Incorrect Option:
(A) Insert menu does not contain the Spelling and Grammar check option.
8. Correct Option:
(A) Select Table — Insert — Table to open Insert Table dialog box.
Incorrect Option:
Rests of the options are invalid.
9. Correct Option:
(A) Select Format Change Case allows opening change case dialog box.
Incorrect Option:
Rests of the options are invalid
10. Correct Option:
(A) Select Insert — Picture — ClipArt to open ClipArt.
Incorrect Option:
Rests of the options are invalid
Answers
1. 2. A 3. B 4. D 5. D 6. D 7. C 10.




